
AdMaker 3.5
Small Display Ad Designer for Windows

(Un-Registered Shareware Version)

INTRODUCTION

For most small businesses, producing small display advertisements for newspapers, newsletters, 
and fliers is a tough, expensive job. Either you have to have a full-scale desktop publishing 
program or hire someone to create your simple ad. AdMaker is designed to let you create your 
own small display ads in minutes. While it's not suitable for color ads for slick magazines, the 
program is ideal for smaller ads in other publications.

AdMaker can produce ad layouts ranging in size from as small as you like up to 7.5 inches by 9.5 
inches, large enough for most any purpose. It produces camera-ready copy from any Windows-
compatible printer, although laser printers produce the best results. For a complete features list, 
see below. You'll be amazed at how quickly you can produce quality ad layouts, using AdMaker.

SYSTEM REQUIREMENTS
Admaker requires a 386/486 CPU, Windows 3.1, a hard disk and mouse, plus a minimum of 2 
MB of RAM and 2 MB of hard disk space, VGA or better graphics and a Windows compatible 
graphics printer  You'll also need about 6 MB of free disk space on the disk where you store .TMP
files for Temporary files. This program supports only TrueType and Adobe Type Manager fonts. 
HP DeskJet users: Admaker supports all models of these printers.  See the section on HP 
DeskJet printers near the end of this manual.

Admaker 3.5 includes a large set of features. Please read this manual thoroughly. It'll save you a
lot of time and help you use the program better.

VBRUN300.DLL REQUIRED
This program requires that the VBRUN300.DLL file, the runtime file for Visual Basic 3.0 programs
be installed in your WINDOWS\SYSTEM directory. You may obtain a copy of this file as 
VBRUN300.ZIP on the OsoSoft BBS, at the number below.

Admaker's FEATURES
Use any TrueType or Adobe Type Manager Font
Insert up to Four BMP or PCX Clip Art Images
Easy, Proportional Graphics Scaling
Simple Interface
Draw Lines, Boxes and Circles, Plus Fills and Shading
Overlay Text on Clip art or Filled Boxes and Circles
Create Camera-Ready Layouts at 100% & 200% Size
Create Ad Layouts up to 7.5" X 9.5"
Use any Measurement System
Works with Any Windows-Compatible Printer
WYSIWYG Display
Full Support for Color Printers
Click to Position Text Instantly
Rotate Text
Insert Foreign or Symbolic Characters
Right-Click Help

LICENSE INFORMATION



This is the unregistered version of AdMaker 3.5. AdMaker is a shareware program. You may try 
this copy of the program for a period not to exceed 30 days to determine whether or not it is 
suitable for your needs. After that time, if you continue to use the program, you must register your
copy with the author. To register, use the OsoSoft Program Info command in the Help Menu to 
print the registration form. The Registration fee for this program is $30.

You can also register with a Visa or MasterCard by calling OsoSoft at (805) 528-1759 during 
normal West Coast business hours. Credit card orders incur a $4 shipping and handling fee for 
each order, regardless of how many programs are ordered. OsoSoft programs may also be 
registered on CompuServe in the SWREG forum. Registrations will be charged to your 
CompuServe account.

Registered users receive the very latest version of the program, a printed manual, additional clip 
art images, automatic notification of major upgrades, and support. In addition, when you register, 
you'll always be entitled to upgrade to new registered versions at no charge on the OsoSoft BBS 
at (805) 528-3753. Registered users are entitled to unlimited free support by telephone, fax, on 
the OsoSoft BBS, and on Compuserve. 

Unregistered users receive only a minimum of support, limited to some installation help, if 
necessary, and are not entitled to telephone support. If you call the OsoSoft voice number for 
support as an unregistered user, you will be asked to register at that time by credit card.�

Users of this program, along with traditional shareware distributors may distribute copies of  the 
shareware versions of this program, but only under the terms described in the VENDOR.DOC file 
included with this copy of the program. All commercial distributors MUST read that file and abide 
by the distribution rules contained in that file. Violations of the distribution license in 
VENDOR.DOC may result in prosecution under appropriate copyright laws of the United States 
and other countries.

AdMaker and all related files, including this documentation are Copyright 1991,1994 by OsoSoft. 
All rights are reserved.

OsoSoft is a member of the Association of Shareware Professionals and the Software Publishers'
Association.

OsoSoft
1472 Sixth Street
Los Osos, CA  93402
OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
CompuServe ID: 71571,222

HOURS
OsoSoft business hours are 7 AM to 4 PM, Pacific Time, on weekdays. Calls outside those hours 
are not appreciated.

ASP OMBUDSMAN NOTICE
This program is produced by a member of the Association of Shareware Professionals (ASP). 
ASP wants to make sure that the shareware principle works for you. If you are unable to resolve a
shareware-related problem with an ASP member by contacting that member directly, ASP may be
able to help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not provide technical support for members' products. Please write to the ASP 
Ombudsman at 545 Grover Road, Muskegon, MI 49422-9427 USA FAX 619-788-2765 or send a 
CompuServe message via CompuServe mail to ASP Ombudsman 70007,3536.



INSTALLATION
The Shareware and Online Update versions of AdMaker use a manual installation technique. The
Full Registered Version includes an automated installation program. To install this program, take 
the following steps. If you need help with any of the file and directory procedures, consult your 
Windows or DOS Manual.

1. Copy all files from the distribution diskette or the ZIP file containing the program into a directory
on your hard disk. OsoSoft recommends that you create a directory called ADMAKER for the 
files.

2. Now, copy all files with the extensions .DLL and .VBX from the ADMAKER directory into your 
WINDOWS\SYSTEM directory. If you're working from the DOS prompt while in the ADMAKER 
directory, the commands would be:

COPY *.DLL C:\WINDOWS\SYSTEM
COPY *.VBX C:\WINDOWS\SYSTEM

Naturally, you'd substitute your own drive and directory information if you installed Windows in a 
different directory.

NOTE: Once you have successfully copied all DLL and VBX files into the WINDOWS\SYSTEM 
directory, you may delete them from the AdMaker home directory, if desired, to save disk space. 
Do not, however, delete any other files.

You must also have a copy of VBRUN300.DLL in your WINDOWS\SYSTEM directory. See the 
note above if you do not have a copy of that file.

3. If Windows is not running, start it. Then, from the Program Manager, click once inside the 
program group where you want the AdMaker icon. Then, select the New command from the 
Program Manager's File menu. Make certain the Program Item option is selected, then click OK 
or press <Enter>.

4. In the Description field of the resulting dialog box, type AdMaker, then press <Tab>.

5. In the Command Line field, type C:\ADMAKER\ADMAKER.EXE, substituting other drive and 
directory information, if necessary. Press <Tab>.

6. In the Working Directory field, type C:\ADMAKER, or substitute other drive and path 
information, if necessary.

7. Press <Enter> or click OK to complete the installation. The AdMaker icon will appear in the 
program group you selected earlier.

USING Admaker
To run Admaker, start Windows, then double click on the Admaker icon in the Program Manager. 
A notice will appear on your screen as the program loads and creates its font list. If you have a 
large font library, this may take up to a minute. On subsequent program loading, the program will 
load the font list from its own file.  You'll also have a chance the first time the program loads to 
create a customized heading text for camera-ready layouts. Use this text to advertise your 
business.

Next, you'll see the Admaker main screen. The program opens with the Layout menu dropped 
down so you can load a template file or specify the size of a layout. Unlike many other Windows  



programs, Admaker  uses command buttons and drop-down list boxes, rather than menus, to 
perform many functions. Most commands you need to create ad designs are right on the screen, 
grouped according to function. Traditional Windows menus offer other commands. As with most 
Windows programs, shortcut keys are available for most functions.

RIGHT-CLICK HELP TIP: Whenever you wonder what a button or command does in Admaker, 
just right click on the button. A help line will appear in the Admaker title bar.

EDITING AND DISPLAY WINDOWS
You'll see two windows on the screen. At the top is the text-editing window. Here, you'll enter and 
edit all the text to be included on your ad. Just below it is another window, where a WYSIWYG 
display of your ad appears. You can't edit directly in this window, although many functions operate
by clicking in this window.

Editing Text in Admaker 
Admaker''s text box works much like your Windows word processing program. You can simply 
type your text in the box, pressing <Enter> to move to a new line. To position the cursor in your 
text, use the cursor keys or click the mouse pointer where you want to type. If you select text by 
dragging with the mouse, new text you type replaces the selected text. The WYSIWYG display 
updates when you press <Enter> or perform any formatting command. When you're entering text,
all attributes continue from line to line when you press the <Enter> key. When you delete lines, 
remaining text maintains its formatting. You are limited to 120 lines of text in Admaker.

NOTE: It's very important to remember that Admaker depends on line numbers for its formatting. 
Before performing any formatting operation, select the line of text you want to format, by 
positioning the cursor in the text window.

TUTORIAL: YOUR FIRST LAYOUT
Getting to know any program takes some time, plus careful reading of the manual. However, to 
speed up your introduction to Admaker, here's a guide to producing your first ad layout. Just start 
Admaker, then follow the steps below. 

In the Layout menu, select the  Design Ad Template command. When prompted, enter the 
horizontal and vertical size for your layout. The default measurement system is inches, but you 
can enter dimensions in any measurement system you wish.  Just type an abbreviation after the 
dimension. Valid abbreviations are cm, mm, pt, pi, for centimeters, millimeters, points, or picas, 
respectively.

Choose a font and font size for the first line of your layout, using the drop-down lists at the right of
your screen.

Type in the first line of your ad. Don't press <Enter> yet.

Choose an alignment for your text in the drop down list at the right of your screen. Left aligned is 
the default. TIP: If you want all the lines of your ad to be aligned the same way, click the Layout 
menu and choose one of the alignment options there.

Press <Enter>, then type the next line for your ad. Notice that your text appears in the 
WYSIWYG window, aligned just the way you chose. As long as you don't make any formatting 
changes, each line will have the same formatting as the first line.

Continue typing lines of text for your ad until you've entered all your text. You don't have to press 
<Enter> after the last line to see that line on the screen. Click the [Update] button.



Now that all your text is entered, you can make layout changes. Start by making the first line a 
little larger than the others. To do this, click with the mouse on the first line in the Text Box at the 
top of the screen. Then, drop down the Font Size list on the right and click on a larger font size. 
The WYSIWYG screen will update instantly.

Now, let's add boldfacing to the first line. Since the cursor's already on that line, just click the 
Bold checkbox on the top right section of the screen. Check the WYSIWYG window.

These changes may have caused the last line of your ad to run off the window. Move the cursor 
to the second line in the Text Box, and reduce the font size slightly. To make the remaining lines 
the same, move the cursor down to each line, then click the [Dupe Prev] button.

NOTE: All formatting commands operate on the line where the text box cursor is located.

If you want to place some text on both sides of the lower section of the ad, as for address and 
telephone number blocks, type both items on one line, placing a tilde (~) at the point you want to 
split the line. Then, select the Split at Tilde alignment option from the alignment list. The line will 
automatically split, with half on one side of the ad and half on the other side.

If you'd like to add one or more graphic images to your ad, click the [AddArt] button and select a 
graphic file from the list, then click OK. The image will appear on the left side of your ad. You can 
use up to four images per ad. Each will appear in a different corner of the layout, but can be freely
moved.

If the image is too large, use the [Scale] Scroll Bar in the Clip Art section of the commands on 
the right to decrease its size.

To move an graphic, make sure that the 1, 2, 3, or 4 option button is marked to select an image, 
then left-click in the WYSIWYG window outside of the graphic. Hold down the button to drag the 
image around until it's where you want.

To position text in a particular position, select the line in the text box, then click the Click to Move
Text check box. Now, click in the WYSIWYG window where you want the upper left corner of the 
line of text. You can repeat this function as often as you like. For more precise positioning, click 
the Grid button to overlay a .1 inch grid on the window.

If you want to add a line, box or circle to your ad, click the appropriate item on the bottom right of 
your screen. Choose a color, if desired, plus a line width if you want something other than a thin 
line, then click the [Draw] check box. Now left-click in the WYSIWYG window where you want the
object's upper left corner and drag the object to size. When you release the mouse button, the 
object will appear. 
When your ad looks just the way you want, click the File menu, then click Print 100% Size 
Layout. Print your test on inexpensive paper. 

Finally, select the Print 100% Sized Layout  or Print 200% Size Layout command in the File 
Menu to print out your final layout on high-quality reproduction paper.

This brief tutorial will help you understand the principles of using Admaker. The program can do 
much, much more than produce simple layouts. Read the rest of this manual to discover 
Admaker's other features and experiment with them until you're comfortable using them on actual
layouts.

COMMAND REFERENCE

LEFT SIDE COMMAND BUTTONS



The Text Group
[Edit]--This button returns the cursor to the text editing box. Since Admaker normally returns 
control to this box, you'll rarely, if ever, have to click this button.

[Click to Move Text]--This command is new to version 3.5, and lets you move text instantly to 
any position. To use this check box, position your cursor on the line of text you want to move. 
Then click this command. Now, click on the WYSIWYG display where you want the upper left 
corner of the text to appear. To move the same text, repeat the process above.

[TextColor]--Admaker 3.5 can print text in color on color printers. To choose a color, first place 
your text box cursor on the line you want to change. Then click a color bar. NOTE: On most non-
color printers colored text will print as a shade of gray.

The Layout Group
[Update]--This button updates the WYSIWYG display. To improve performance, some commands
used in Admaker do not automatically update this display.

[Clear]--This button clears your current ad from the screen and from memory. You'll be asked to 
confirm this command in a dialog box. 

[Grid}--This button overlays a grid on the WYSIWYG display, to help you position text and 
graphics. The grid has divisions of .1-inch, with full inch lines in bold. Click the button again to 
remove the grid. Use this feature with clip art and when using custom alignment.

[Zoom]--This button shows larger layouts at full size. While you can't edit in this mode, it's a good
way to see an enlarged view of your ad. Use the scroll bars to view the entire layout. Click the 
button again to return to the reduced size editing view.

[Scale]--Displays the current zoom percentage. For smaller ads, this will be 100%. For larger 
layout sizes it will be a smaller number.

RIGHT SIDE COMMANDS

Text Attributes (Whole Line)
[Line]--Displays the current line number, as determined by the position of your cursor in the text 
editing box.

[Dupe Previous]--This button allows you to repeat the formatting of the line above the current 
line. This is useful whenever you want duplicate formats on several lines. Just format any line, 
then move to the next line and click this button. All line attributes will be duplicated. When typing, 
pressing <Enter> automatically copies the previous line's formatting.

[Font]--This drop-down list box displays the current font, and allows you to change a line to 
another font. Click on the arrow to drop down the font selection list. Scroll through the list, then 
click on your font selection.  

[Size]--Displays the current size for the font used on the current line. Click the arrow to drop 
down a list of available font sizes for the line. Sizes range from 4 to 72 points, in one-point 
intervals for the smaller fonts. HINT: Changing the font size of a blank line affects line spacing. 
Use this trick to adjust line spacing in 1-point intervals.

[Align]--This control affects the alignment of the selected line. To change, click the arrow, then 
select your option. You can choose left or right aligned, centered, split lines, or set a customized 
horizontal and vertical position. HINT: When using customized line positions, apply these to lines 



at the bottom of the ad's text to avoid later misalignments in normal lines.

NOTE: For split lines, insert a tilde (~) in the text box where you want the line to split. Admaker 
will automatically separate the two halves of the line. You cannot insert internal formatting codes 
in split lines. Lines are split with the left half aligned with the left margin and the right half aligned 
with the right margin. 

[Style]--Four check boxes control text attributes for the entire line.  You can select more than one 
style for any line. Clicking [Normal] removes all other style settings.

[Rotate]--Admaker lets you rotate text up to 90 degrees in either direction. Start by selected the 
line to rotate, as you normally do, then click this button. Use the scroll bars in the dialog box that 
appears to set a rotation angle, then click [Accept] to apply the rotation. You can also click [No 
Change] to keep the current rotation or [Default] to return to normal alignment. TIP: Combine 
rotation with the [Click to Move Text] feature to position rotated text wherever you want it.
The Clip Art Group

[AddArt]--Opens a dialog box for loading .BMP or .PCX clip art images. Admaker supports black 
and white or color images up to 256 colors. To see a preview of an image, click once on the 
filename. To load the image, double-click the file or click OK. Admaker will automatically select 
either the first unused clip art image, and position it in the WYSIWYG display. TIP: If your desired 
clip art image appears much too large or small, edit it in a graphics program to make it 
approximately the correct size before importing it into your ad. 

[HideArt]--This button temporarily removes all clip art and line drawing art from the WYSIWYG 
display. Since Admaker can overlay text on a graphic or line art object, use this command to help 
you see text position if it is hidden by a clip art image. When clip art is hidden, a dotted box shows
its location for alignment purposes. When you click this command, its caption changes to 
[ShowArt]. Clicking it again will redisplay your graphics.

[Delete]--Removes the currently-selected clip art image. 

[Option Buttons]--Selects one of the four clip art images. You may select by clicking the button, 
or by double-clicking on the image itself. You must select an image before acting on it. Options 
are 1, 2, 3, or 4. Normally, PIC 1 is at the left top corner of the ad, PIC 2 at the right top corner of 
the ad. 3 and 4 are in the two bottom corners.  When selected, a thin border will appear around 
the image.

[Scale]--Use this control to resize a selected clip art image. Remember, the command only 
affects the image selected with the option buttons. For small changes, click the arrows. Click 
between the arrows for larger changes. The image always stays in proportion.  You can scale 
images between 10% to 500% of the original size.

HINT: Avoid major changes in clip art image size, to avoid image degradation. If you need to 
enlarge or reduce an image very much, do so in a paint program like Windows Paintbrush before 
loading it into Admaker. This will result in an improved appearance on your ad, since paint 
programs have sophisticated scaling routines. You can edit the currently selected image with the 
Edit Image command in the Edit menu. If you do this, after editing the image, delete the current 
image, then reload the new version from disk with the [AddArt] button.

Moving a Clip Art Image
You can move a clip art image by dragging it around the screen with the mouse. To do this, first 
select the image you want to move by clicking the appropriate option button in the Clip Art 
Group, or by double-clicking on the image itself. When the image is selected, a thin border 
appears around the image. With the image selected, click the left mouse button in the WYSIWYG
display somewhere outside of the image. The image will instantly move, with its upper, left corner



at the position where you clicked. Then, with the mouse button held down, you can drag the 
image to a new location. The new location is stored with the ad when you save. If you try to drag 
the image by first clicking on the image, a message will appear telling you to click outside the 
image. For precise positioning, try turning on the [Grid] display before positioning the image.

The Line Drawing Group
[Object]--This drop-down list box allows you to select an individual object for editing.  If you do 
line drawings, each line, box, or circle gets an object number, which appears near the object. 
Select the object you want to modify in this list box.

[Width]--This box controls the width of line drawing elements. Widths range from 1 to 24 pixels 
on the screen, which translates roughly to point measurements on the printer. If you change the 
current setting, it will affect the current object, if present, or the next object you draw.

[Draw]--This check box enables line drawing. Click it before creating an object. Admaker will 
automatically select the first available object number.

[Filled]--This check box appears only when you've drawn or selected a box or circle. If you check
it, the box or circle will be filled with the same color used to draw the box. Uncheck it to remove 
the fill.  NOTE: Some printers always draw a solid black box around the object. This can't be 
prevented, so test your work by printing a sample ad. 

TIP: Admaker can print text inside filled boxes. Use this technique to create boxes filled with one 
color, then use a contrasting color for the text. Use this technique too to produce reversed, white 
on black text. Just draw a filled box around your text, then change the text color to white. On 
black and white printers, you'll have to experiment to get just the right effect. Also, remember that 
you can position text with the [Click to Move Text] command.

[Line], [Box], [Circle]--These options determine the type of object you want to draw.

[LineColor]--This set of color bars lets you set the line and fill color for either a new object or for 
an existing object picked from the object list. Select the object, then apply a color. The same color
is used for both the lines and fill. 

DRAWING AN OBJECT
To draw an object in the WYSIWYG screen, first select the type of object ([Line] [Box] [Circle]), 
then set the width for the lines used to draw the object, and the color for that object. Next click on 
the [Draw] checkbox. Move the mouse pointer inside the WYSIWYG display. While holding the 
left button down, drag the mouse pointer to a new location. A rubber-band image of your object 
will appear as you draw. Draw slowly for best results. When the object is approximately the right 
size, release the left mouse button to place your object on the screen. A number will appear next 
to the object to identify it. You can move or size any object later.

NOTE: Admaker does not check to make sure your object is within the boundaries of the ad. 
That's your responsibility. Objects extending past the ad's edges WILL print outside the ad's 
boundaries.

TIP: Admaker automatically converts all lines drawn at small angles to either horizontal or vertical
straight lines. Lines drawn at other angles will maintain their angle.

[Move], [Size] Options--These two options determine whether the scroll bars (see below) move 
or size the current object.

[Scroll Bars]--Horizontal and vertical scroll bars control positioning of graphical elements. 
Depending on which of the option buttons above is selected, you can move or scale all graphical 



objects in .005 inch increments. Try the [Grid] command for accuracy.

MOVING AN OBJECT 
Start by selecting the object in the [Object] list box. Next, click on the [Move] option button. To 
move the object in .005" increments, click on the [Up], [Down], [Left], or [Right] arrows on the 
appropriate scroll bar. To move the object in .05" increments, click the scroll bar regions between 
the arrows and the position button on the scroll bar. To move the object in larger increments, click 
and drag the thumb on either scroll bar.

SCALING A LINE DRAWING OBJECT
First, select the object you want to resize, then click the [Size] option button. Then use the scroll 
bars as described above to alter the size of the object. 

Erasing and Restoring Line Drawing Objects
[Erase Selected]--This button erases the current image, as identified in the [Object] list box. 
This erasure is permanent. 
[Erase All]--This button removes all graphical elements from the screen. 

MENU COMMANDS

FILE MENU
New Layout File--Clears the current ad and sets up for a new design. If a ad is already on the 
screen, you'll be prompted to clear it or abort.

Open Layout File--Opens an existing .LAY ad design file. For simplicity, store your layouts in the 
Admaker home directory.

Save Current Layout--Saves the current ad with the current filename. The current file will be 
overwritten without warning. If you're making a different ad, use the Save As... command.

Save Current Layout As...--Lets you save the current design under a different filename.

Insert Graphic File--Lets you select a clip art image for insertion in your design. Admaker 
supports up to four clip art images on each ad. Same as [AddArt].

Print 100% Size Layout--This command prints your layout at full size, with optional crop marks 
and message text.

Print 200% Size Layout--this command prints a 200% enlargement of your layout. NOTE: If the 
ad is too large to print at 200%, this command will be grayed out an unavailable. Again, crop 
marks are optional. Use this command whenever possible to allow the publisher to reduce the ad,
which will give it better resolution when printed. The actual size of the ad is always printed on the 
page for reference.

Print Color Sample--Every printer handles color differently. Use this command to print samples 
of text in all the colors shown on the color bar chart. For black and white printers, this will produce
shades of gray in most cases. NOTE: If some of the colors print as black on color printers, 
change the Dithering setting in your Printer Driver, using the Printer Setup command.

Printer Setup--Use this command to alter printer settings or to change printers. You'll see the 
normal Windows Printer Setup dialog box for your printer. When you return to the program, you'll 
be asked if you want to update your font list. If you changed printers, you should answer Yes to 
avoid font conflicts.

Update Font List--Admaker handles fonts very well, but there may be times when you need to 



relist your currently available fonts. This command does that. You probably will never need to use 
it, since the program rebuilds its font list, if necessary, each time it starts.

Exit--Quits Admaker, with a confirmation box. Click [Yes] to save the current ad and exit. Click 
[No] to exit without saving. Click [Cancel] to return to Admaker. If you've changed printer settings
during your session, you'll be asked if you want to reset printer options.

EDIT MENU
Cut--Removes selected text from the editing box, then stores it in the clipboard. 

Copy--Sends a copy of selected text to the clipboard. 

Paste--Copies text from the Windows clipboard to the current cursor location. 

Insert Special Character--This new command pops up a grid showing all the special, foreign, 
and symbolic characters available in the currently selected font. Hold down the left mouse button 
over a character to see an enlarged view. Double-click on a character to add it to the box at the 
top of the screen. When you click the Insert command, all characters in the box will be inserted at
the current cursor location.

Edit Layout Text--This command lets you edit the advertising text used on camera-ready 
layouts.

Edit Current Picture--Starts Windows PaintBrush and loads the picture selected with the option 
buttons for editing. When you exit PaintBrush, you'll return to Admaker. To use the altered image, 
delete the current image, then use [AddArt] to reload the image from disk.

LAYOUT MENU
Design Ad Template--Lets you create a new ad template, specifying horizontal and vertical 
dimensions. This command is highlighted each time you start the program.

Measurement System: Normally, you'll enter dimensions in inches (1.5, 2.33, etc.), but you can 
use any system of measurement by adding an abbreviation after the measurement. This is true 
any time Admaker asks for measurements. The abbreviations are, mm for millimeters, cm for 
centimeters, pt for points and pi for picas. abbreviations can be in upper or lower case, but must 
follow the number, with or without a space. Valid Examples: 2mm, .21 cm, 2PT, .5 PI.

Save Current Ad Template--This command lets you save a template with the measurements of 
the current layout. Use this command create dimensional templates for all the ad sizes you 
normally use. Only the dimensions are stored, so you can use the command even on ads where 
you've already entered text. When you want to save an actual completed ad, use the command in
the file menu instead.

Open Ad Template--Use this command to retrieve previously-saved dimensional templates you 
create. Again, only the dimensions are retrieved.

Rotate Current Line--Like the [Rotate] button, this command displays the text rotation dialog 
box for the current line.

Show Grid--Like the [Grid] button, this overlays a grid on your WYSIWYG display. The grid 
disappears when you give the command again.

Margins--Sets left or top margins separately for text. Choose the appropriate subcommand. 
Small changes have big effects, so start with small margin measurements. The default is .1 inch. 
You may use any measurement system, as described earlier. NOTE: Margins affect only text, and



can be overridden by either the Click to Position Text or Custom Alignment options. Use this 
command to set margins for the starting position of most text on the layout.

Left Align All Lines--Sets all lines on a ad to the left margin. You can override this setting or any 
of the other All Lines settings, by using the Align list box.

Center All Lines--Centers all lines on the ad. 

Right Align All Lines--Sets alignment for all lines to the right margin.

Insert Formatting Codes--The commands in this submenu insert special codes in your 
document which allow you to alter the appearance of just part of a line. Whenever possible, use 
the whole line formatting tools instead.

Normal--Inserts <Norm> in the line. This code returns the line to normal text.
Bold--Inserts <Bold> in the line, boldfacing the following text.
Ital--Inserts <Ital> in the line, italicizing the following text.
Underline--Inserts <Undr> in the line, underlining the following text.
Superscript--Inserts <Supr> in the line, superscripting the following text.
Subscript--Inserts <Subs> in the line, subscripting the following text.

NOTE: You cannot use inserted codes in Rotated Text or in lines which have their alignment set 
to Centered, Right-Aligned, or Split at Tilde. This would cause misalignments.

OPTIONS MENU
Make Current Font Name Default--This command sets the current font, as highlighted in the 
font menu, as the default for all blank lines in your ad. It's best to use this command before 
entering any text.

Make Current Font Size Default--As above, but sets the current font size as the default for blank
lines in your ad.

Save Default Settings--Stores the Font, and Font Size settings made earlier in a file which is 
loaded each time Admaker runs. Use this command if you want to save these settings for use in 
most layouts.

Delete Default Settings--Deletes the default settings file. Use this command if you want to make 
a permanent change in your default Font, Font Size and settings.

HELP MENU
Help with AdMaker  <F1>--This command opens a new window. On the left is an index of topics.
To get help on a topic, just click on the topic's name. You can scroll through the list or type the first
letter of your topic. Once the program finds the topic, the index name will appear at the top of the 
screen to the right, with the help information below. In some cases, a topic will have more than 
one entry. 

About--Displays information about Admaker, including the current version number and support 
information.

OsoSoft Program Information--OsoSoft offers several other programs which may interest you. 
This command displays a window that lets you learn about these other programs and lets you 
order OsoSoft products. To view information on a program, click the [Info] button next to that 
program's name. To order, enter the quantity desired for each product. Then fill out your name 
and address information and mark the appropriate disk size box with an X. Click the [Print] 
button to print the form or the [Cancel] button to return to Admaker.



NOTE: You can always order OsoSoft products with your Visa or MasterCard as well. Just call 
(805) 528-1759 to order.

EDITING YOUR DESIGNS
Editing Text
The easiest way to replace existing text with new text is to highlight existing text by dragging over 
it with the mouse, one line at a time. Once the text is highlighted, just type your new text, which 
will automatically replace the highlighted text.

Controlling Line Spacing
To make fine changes in the spacing between lines of text, make sure there's at least one blank 
line between the lines you want to change. Then, position the cursor on a blank line and change 
the font size for that line. When you update the display, you'll see the changes on your screen. 
You can make changes in 1-point (1/72") intervals. If you need a font size smaller or large than 
those offered in the font size list, simply type it in the display area of the list. Admaker does not 
accept fractional font sizes.

Placing Text Beside Clip Art
You'll often want to position text next to or around clip art images. To do this, use the [Alignment]
options or the Click to Position Text check box.. For example, to position text to the right of an 
image, choose the Right Aligned alignment option, then add spaces after the text to move it to 
the position you want. Similarly, use the Left Aligned option to position text to the left of an 
image. This time, however, place your spaces to the left of the text. To wrap text on both sides of 
an image, insert a tilde (~) where you want the text to break, then choose the Split at Tilde 
alignment option. Once again, pad the text with spaces to achieve the position you need. Don't 
forget the Custom Alignment and Click to Move Text options for even more precise positioning 
of lines.

Overlaying Graphics with Text
You can print text on top of clip art graphics, but you cannot view this text on the screen. To see 
text which will overlay a clip art image, click the [HideArt] button. A dotted box will appear to 
show where the graphic is located. You can then use the Click to Move Text option to pop text into
position.  Use overlaid text with caution, since it may obscure part of a clip art image. HINT: Try 
using a contrasting color for text which overlays a graphic.

TIP: You can create excellent effects by adding a clip art image which has a box in it for text, such
as the FRAME series of images included with this program. Then, add text to the image to 
customize the frame to suit your purposes.

Working with Split Lines
Admaker's ability to split lines is very powerful, letting you position blocks of text on both sides of 
the ad. Normally, the left half of the line is flush with the left margin, while the right half is right-
aligned. Often, however, you'll want to center blocks of text or manipulate the alignment in other 
ways. As described above, use spaces to pad the text until it's aligned just the way you want. 

Creating Columns in Admaker
It's easy to create columns for text. To do this, select a custom alignment or use the Click to 
Move Text command for the first line in the column, positioning it exactly where you want it to 
appear on your ad. Then, either enter new  text on subsequent lines or click the [Dupe Prev] 
button on subsequent lines. All lines will line up with the first line. TIP: When creating columns of 
text, it's best to place this text at the bottom of the text in the text window. This helps prevent 
misalignments of other text.



Working With Rotated Text
If you want to use rotated text on a ad, it's best to add the text to the bottom of the text box text. 
This helps prevent misalignments of other text on the ad. Before typing the text to be rotated, 
click the Click to Move Text check box, then click in the WYSIWYG window where you want the 
top left of the text to appear. Then type the text and click [Update]. You can use the Click to 
Move Text as often as you like to get just the right positioning.

Creating Reverses (white on black) and Other Text Effects
Draw a filled box, using black or another color for the box. Then, set the text you want to place in 
the box to white or a contrasting color. Use the Click to Move Text command to position the text 
inside the filled box. Since colored text and fills print as shades of gray on most printers, you can 
achieve various effects by mixing fill and text colors. Print samples to see the actual results. You 
can also draw a filled box around existing text for the same effect. Just remember to set the text 
color to contrast with your filled area.

Creating Borders
It's easy to use the line drawing tools to create borders for your layout. Try using the Grid button 
to display the alignment grid on your layout for better accuracy. Experiment with multiple borders, 
each having a different line thickness.

Background Shading
By drawing a large, filled box, almost the size of the entire ad, using a light gray color for the fill, 
you can add a distinctive background to your layout. Use this technique with caution though, and 
don't use small type on these layouts, since it tends to disappear.

Printing Samples
When working with complex ad designs, it's a good idea to print frequent samples of your design 
for checking. After printing a sample, you can make changes to correct slight misalignments. For 
speed, use the Print 100% Size Layout command.  

Printing Final Output
When printing actual camera-ready layouts, use paper specially designed for camera-ready 
output or high-quality, bright white paper. Set your printer's density setting to whatever level is 
needed to produce 100% black. Make sure your printer is clean internally and has a good toner 
cartridge or ink cartridge. Be sure to include the crop marks in final copy, since the publisher will 
need those marks for precise positioning.

Spot Color
If you need to add spot color to an ad, create two ads, one with just the black material and one 
with the color material. Do not take an ad printed in color to your publisher...they can't use it. 
Instead, lay out as many separate images as you need, one for each color used in the ad, but 
print each ad in pure black. AdMaker is more than accurate enough in its printouts for good 
registration at the print shop.

HINT: To get all those colors lined up properly, include all elements on one master ad, then reset 
the color of items not needed in a particular printout to white. Print one color's version, then 
change other elements from white to black or the opposite. Be sure and save separate files for 
each color. Just remember, your publisher or printer needs one black printout for each color used 
in the final Ad.

TIP: If you have a color printer, use it to produce a master printout to take to the publisher or print 
shop as a guide to the way the final ad should look.

Admaker TIPS 



Printing
Printing takes time. Admaker and Windows have to compose graphical pages before a page 
emerges. You'll need a little patience.

For maximum quality when printing Admaker ad designs, be sure your laser printer has a good 
toner cartridge. If you can set print density, choose a medium or dense setting to achieve dark 
blacks for reproduction. 

Admaker can handle color clip art images, but the final output will depend on how your printer 
interprets the colors in your clip art.  HINT: If some colors print as black on a color printer, change
that printer's dithering settings in the Printer Setup dialog box. You may have to click Options  in
the dialog box to get to these settings.

Notes for HP DeskJet Users
Try setting the paper size to Legal if your printer ejects pages and doesn't print the crop marks on
large layouts

DeskJet color printers may print some of the colors as black if Dithering is set to Standard. To fix
this, set the printer for any other Dithering type in the Options section of the Printer Setup 
dialog box.

REMEMBER: Load paper face down in your DeskJet's paper tray!

Working With Clip Art Images
Admaker accepts both .BMP and .PCX graphics files. Graphics programs, such as Windows 
Paintbrush, supplied with Windows 3.x, can create these files. You can convert other file types, 
using any of a number of format conversion programs, such as HIJAAK, Publisher's PaintBrush, 
and others. 

The size of your image is important. Art for small ads is quite small, almost never exceeding 1" in 
any dimension. While Admaker can handle much larger images, it's usually better to scale large 
images in a program specifically designed to do that. Windows Paintbrush can handle preliminary
scaling quite well. If you have a scanner, you can create your own clip art in minutes. Simply scan
the image, then use your scanner software to produce a .BMP or .PCX file approximately 300 
pixels in each dimension. Naturally, tall narrow images will use other dimensions, but you get the 
idea. 

You can also create clip art images with any paint program that can produce .BMP or .PCX files. 
Creating custom logos isn't difficult at all. Also, a number of clip art libraries are available, both 
commercially and as shareware. Often, however, these images may need conversion to a 
supported format or scaling. You'll also find interesting clip art files on the OsoSoft BBS.

Clip Art Tips
Very thin lines often don't print well.

Large black areas may present problems for your laser printer, and sometimes don't reproduce as
completely black.

Reducing a large image to ad logo size often results in loss of detail.

Increasing the size of tiny images usually results in jagged lines on your printout.

Lines, Boxes, and Circles
You cannot draw a graphical element that extends into a clip art image. The line will end at the 
edge of the image. You can, however, overwrite text with a line graphic. Let the WYSIWYG 



display be your guide. Be careful not to let lines, boxes, or circles extend past the ad's borders. 
Always check the WYSIWYG display for conflicts.

Use the [Update] button to see the results of your changes. As you draw and move lines, text 
may not appear if it has been overwritten. Update to see the actual image.

Use the [Draw White] option to create special effects. Combining thick lines with intersecting 
white lines can create interesting effects. You can create quite complex drawings using the line 
drawing tools alone, including simple logos.

You can also draw boxes or circles, with fills, around existing text on your design. It's best to first 
create the text, then follow up with lines, boxes, and circles. Use the positioning scroll bars for 
precise sizing and placement.

Try using a filled box or circle to set off text. Use a light color with black or dark colored text or a 
dark color combined with white text for special effects.

Overlaying white text on a black filled box is the best way to create reversed text. 

TROUBLESHOOTING
Setup Doesn't Work--You may have older versions of some of the files needed by Admaker 
installed in incorrect directories. Load README.WRI into Windows Write and use the manual 
installation procedures described there.

Reversed Printing and Shaded Text Don't Print Correctly--Change your printer settings with 
the Printer Setup command to enable the Print True Type Fonts as Graphics check box.

Clip Art Images Don't Print--Exit Admaker, then run Windows Setup from the icon in Program 
Manager. Change to a graphics driver which displays 256 colors or less. Some high-color display 
drivers are incompatible with Admaker's graphics printing methods.

Small TrueType Fonts Appear Incorrectly in the WYSIWYG Display--Due to the way Windows
handles TrueType fonts smaller than 8.75 points, your WYSIWYG display may not display these 
fonts correctly in small sizes. They will print correctly, however.  If you have Adobe Type Manager,
try a PostScript Type 1 font instead.

Some Colors Print as Black on My DeskJet Printer--To print all the possible colors, you need 
to reset the Dithering Setting in Printer Setup. 

Rotated Text Messes Up My Layout--To prevent this, enter text to be rotated at the bottom of 
the text in the text editing window, then position it with the Custom Alignment or Click to Move 
Text options, then rotate it. Alignment of text below the rotated text is affected by the rotated text.

I Can't Figure Out What All the Buttons Do--To get Title Bar help on any button and on most 
other items on the screen, click on the item with the right mouse button. 

I Get an Error When I Print Layouts With Graphics--Your graphic files may be too large or you 
may not have enough free hard disk space for the TMP files created by Print Manager. Try scaling
the graphics in another program or turn off Print Manager in the Printer section of the Control 
Panel. Also, your printer may not have enough memory to handle a full page of graphics.


